
File Version Conflict
Use this dialog box to specify whether to keep a currently installed version of a file on 
your system or replace it with a different version. There are several possible reasons why 
the files are in conflict: 

The version of the file that you are trying to install is older than the currently installed
version. 

It is recommended that you keep the currently installed version. 
The new version of the file that you are trying to install is in a different language than

the currently installed version. 
The new version of the file that you are trying to install uses a character set that 

cannot be displayed in this version of Windows. 
The new version of the file that you are trying to install is a different file type from 

the currently installed version. 
To keep your currently installed file, choose the No button. (If the version you are trying to
install is older than the currently installed version, it is recommended that you choose No,
and keep the currently installed file.) To replace your currently installed file with the one 
supplied with Windows version 3.1, choose the Yes button. 



Add/Remove Windows Components
Using this dialog box, you can add useful (but nonessential) Windows components to your
system. You can also remove components to gain disk space. Usually, you will not need to
add components because they are installed when you first set up Windows. 
You can select all or only certain parts of a component. For example, you may want to set 
up some of the Accessories applications, but not others. The check box next to the 
component shows its current status: X = currently installed; gray = some files currently 
installed; blank = no component files installed. 
Note: To leave a component as it is, do not change its check box. Change the check box 

only if you want to add or remove a component or specific files. 
To add or remove a complete component
1 To add, select the check box next to the Component description. 

To remove, clear the check box. 
2 Choose the OK button. 
To add or remove part of a component

Choose the Files button for the component. Then complete the dialog box that 
appears. 

For help, choose the Help button or press F1 while using the dialog box. 



Set Up Applications
Using this dialog box, you can set up applications already installed on your system so 
they will run with Windows. For each application you set up, the Setup program creates 
an icon in a Program Manager group window. While using Windows, you can start the 
application by double-clicking this icon. 
You can direct Setup to search for applications to set up, or you can set up a specific 
application. 
For Keyboard Instructions on setting up applications, press ENTER. 
To set up applications

Select one of the options described below, and then choose the OK button. 
Use To
Search for applications If you select this option, another dialog box appears, 

asking you to specify where you want Setup to search. 
Ask you to specify an application If you select this option, another dialog box appears, 

asking you for the name of the application you want to 
set up. 



Keyboard Instructions

To have Setup search for applications
Press ENTER. 

To have Setup set up a specific application
1 Use the DOWN or UP ARROW to select the "specify" option. 
2 Choose the OK button. 
To quit Setup Help

Press ALT+F4. 



Selecting Applications
This dialog box displays applications that can be set up for use with Windows. These are 
applications that Setup has located in its search of your drive(s). 
Setup identifies each application by its program filename. At times this may cause a 
naming conflict, since different applications may have the same filename (for example, 
WordPerfect and Microsoft Multiplan both use the name WP.EXE.) If there is a conflict, 
Setup displays a dialog box that asks which application you want to set up. 
For Keyboard Instructions on selecting applications, press ENTER. 
Choose one of the following buttons for information about the dialog box: 
 Applications Found on Hard Disk(s)
 Set Up for Use with Windows
 Add Button
 Remove Button
 Add All Button



Keyboard Instructions

To set up all the listed applications
1 Press ALT+D to choose the Add All button. 
2 Press ENTER. 
To set up an application
1 Use the DOWN ARROW key to move the selection cursor to the application you want to 

add. 
2 Press the SPACEBAR to select the item. 

To make multiple selections, move the selection cursor to each item you want to 
select, and then press the SPACEBAR. 

3 Press ALT+A to choose the Add button. 
4 Press ENTER. 
To remove an application
1 Press TAB to move the selection cursor to the right box. 
2 Use the DOWN ARROW key to move the selection cursor to the application you want to 

remove. 
3 Press the SPACEBAR to select the item. 

To make multiple selections, move the selection cursor to each item you want to 
select, and then press the SPACEBAR. 

4 Press ALT+R to choose the Remove button. 
To quit Setup Help

Press ALT+F4. 



Selecting a PIF
This dialog box asks which program information file (PIF) Windows should use to run the 
specified application. This application has more than one PIF associated with it; each will 
run the application in a slightly different way. For example, one PIF might open a certain 
data file each time the application starts. Another PIF might start the application without 
opening any file. 
Select the PIF that best describes the way you want to run the application. It is 
recommended that you use the PIF supplied by the manufacturer, if one is available. 

Select the PIF you want to use, and then choose the OK button. 



Restart Windows After Setup
Using this dialog box, you can restart Windows or return to the MS-DOS prompt after you 
have finished Windows Setup. 
For Keyboard Instructions on restarting Windows, press ENTER. 
Choose one of the following buttons for information about the dialog box: 
 Restart Windows
 Return to MS-DOS



Keyboard Instructions

To restart Windows now
Press ENTER. 
Or press W. 

To return to the MS-DOS prompt without restarting Windows
Press D. 

To quit Setup Help
Press ALT+F4. 



Restarting Your Computer After Setup
Using this dialog box, you can restart (reboot) your system, restart Windows, or return to 
the MS-DOS prompt after you have finished Windows Setup. 
For Keyboard Instructions on restarting your computer, press ENTER. 
Choose one of the following buttons for information about the dialog box: 
 Reboot
 Restart Windows
 Return to MS-DOS



Keyboard Instructions

To restart your computer now
Press ENTER. 
Or press R. 

To restart Windows without restarting your computer
Press W. 

To return to the MS-DOS prompt without restarting your computer
Press D. 

To quit Setup Help
Press ALT+F4. 



Printer/Port Setup
Use this dialog box to set up your printer or port so that you can print documents from 
Windows. 
To set up a printer
1 Select your printer from the list. Use the scroll bar or arrow keys to see more printers. 
2 Choose the Install button. Or press ENTER. Another dialog box appears, asking you to 

select a port. 
To select a port
1 Select a port from the list (for example, a parallel port such as LPT1, or a serial port 

such as COM1). Use the scroll bar or arrow keys to see more ports. 
2 Choose the Install button. Or press ENTER. 
For information about the ports on your system, see your hardware manual. 



Insert Disks
In this dialog box, you are requested to insert disks to provide files that are copied during 
Setup. 



Select Windows Components
Using this dialog box, you can select which Windows components to add to your system. 
This can be especially useful if you have limited disk space for storing your files. 
You can select all or only certain parts of a component. For example, you may want to set 
up some of the Accessories applications, but not others. 
If the check box contains an X, the complete component will be added to your system. 
To add a complete component
1 Be sure that the check box next to the Component description contains an X. 
2 Choose the OK button. 
To select specific component files

Choose the Files button for the component. Then complete the dialog box that 
appears. 

For help, choose the Help button or press F1 while using the dialog box. 
To choose not to install a component
1 Clear the appropriate check box. 
2 Choose the OK button. 



Overview for Windows Setup Help
If you are new to Windows and need help completing Setup, choose one of the following 
topics. 
To learn how to use Help

Press F1. 
To choose a Help topic

Point to the underlined topic you want to view, and then click the left mouse button. 
When the pointer is on an item you can choose, the pointer changes to a hand icon. 

or
Press TAB to move the selection cursor to the underlined topic, and then press ENTER. 

To quit Windows Setup Help
1 Point to the File menu, and then click. 
2 Click the Exit command. 
or

Press ALT+F4. 



Setup Keys
Use the following keys in Setup. 
Press To
F1 Start Help and display the Contents for Windows Setup Help. 
ALT, SPACEBAR Open the Control menu. 
ALT+DOWN ARROW Open a list. 
ALT + UP or DOWN ARROW Select an item in a drop-down list. 
TAB Move clockwise from area to area within a dialog box. 
SHIFT+TAB Move counterclockwise from area to area. 
ALT + a letter Move to the dialog box option whose underlined letter matches 

the one you type. 
UP or DOWN ARROW Move among items in a list. 
SPACEBAR Select or cancel a selection in a list. 
ENTER Choose a command button, or choose the selected item in a box 

and run the command. 
ESC Close the dialog box without completing the command. 



Choosing an Application Name
In this dialog box, Setup lists applications it found on your system that have the same 
program filename. You need to choose which application to set up to use with Windows. 
To choose an application

Double-click the application name. Or use the UP or DOWN ARROW key to move the 
selection cursor to the application, and then press ENTER. 



Specify an Application Name
Using this dialog box, you specify an application you want to set up to use with Windows. 
You can type the path and filename, or choose the Browse button to select a filename. 
This dialog box has the following areas: 

Application Path and Filename
Type the complete path, including the drive letter and the filename, of the application

you want to set up. 
Add to Program Group

If you want to add the application to a group other than Applications, select the group
you want from the list. 



Browse
Use this dialog box to select the program file for the application you want to set up. 
Choose one of the following buttons for information about the dialog box: 
 File Name
 List Files of Type
 Directories
 Drives



Please Type Your Name and Company Names
In this dialog box, you supply your name and company name, if appropriate, to 
personalize your copy of Windows. 
After you have set up Windows, you can choose the About command from the Help menu 
in Program Manager to see your name. Other system information is also displayed. 



Please Type Your Name
In this dialog box, you supply your name to personalize your copy of Windows. 
After you have set up Windows, you can choose the About command from the Help menu 
in Program Manager to see your name. Other system information is also displayed. 



Please Verify Your Name and Company Name
In this dialog box, you verify the name and company name that you typed to personalize 
your copy of Windows. If either name is incorrect, choose the Change button, and then 
edit to correct the information. 
After you have set up Windows, you can choose the About command from the Help menu 
in Program Manager to see your name. Other system information is also displayed. 



Please Verify the Name You Typed
In this dialog box, you verify the name that you typed to personalize your copy of 
Windows. If the name is incorrect, choose the Change button, and then edit to correct the
information. 
After you have set up Windows, you can choose the About command from the Help menu 
in Program Manager to see your name. Other system information is also displayed. 



Updating Device Drivers
Using this dialog box, you can select which device driver you want to use. Your system 
already has a driver installed that can be used, but you can replace the existing driver 
with a new one, if you want. 
Note: If the driver is currently being used by Windows, you need to quit Windows and 

then run Setup from the MS-DOS prompt. 
You can choose one of the following buttons in the dialog box. 
Use To
Current Keep the existing, installed driver on your system. 
New Delete the existing driver and install the new driver in its place. 
Cancel Close the dialog box and leave your system as it was. 



Changing System Settings
Using this dialog box, you can set up a new display (monitor), keyboard, mouse, or 
network to replace the one you previously had on your system. The procedure for 
changing settings is the same for each area of the dialog box. 
To change a setting
1 Click the arrow at the right of the setting to open the list. Or press ALT+DOWN ARROW. 

Each list displays drivers or devices supported for that setting. Make sure that your 
hardware is listed. 

2 Select the driver or device you want. 
3 Choose the OK button. 

If Setup prompts you for a Windows disk, put the disk in the drive, or type the path of 
the device-driver file. Then choose the OK button. 

4 From the Options menu, choose Exit. 
5 Make sure there are no disks in any floppy disk drive, and then choose the Reboot 

button (if it appears) to restart your system. 
Or choose the Restart Windows button. 

The next time you start Windows, the new settings will take effect. 



Updating OEM Device Drivers
Using this dialog box, you can select the device driver for a piece of hardware you are 
setting up on your system. Setup needs the driver file to properly set up your hardware 
for use with Windows. 
To set up a device driver
1 Select the driver for the hardware you are setting up. 
2 Choose the OK button. Or press ENTER. 



Supply Disks or File Path
This dialog box requires you to either insert the disk containing the file(s) that Setup 
needs or specify the path for the file(s). 
To supply the file path
1 Type the complete path of the driver file(s), including the drive letter. The file(s) may 

be on another drive; for example, on a network drive you are connected to. 
2 Choose the OK button. Or press ENTER. 



Supply OEM Disks or File Path
This dialog box requires you to either insert the disk(s) containing the file(s) that Setup 
needs or specify the path for the file(s). These files are supplied by a hardware 
manufacturer. 
To supply the file path
1 Type the complete path of the driver file(s), including the drive letter. The file(s) may 

be on another drive; for example, on a network drive you are connected to. 
2 Choose the OK button. Or press ENTER. 



Restart After Network Setup
Using this dialog box, you can restart (reboot) your system after you have finished setting
up Windows from a network server. 
Choose one of the following buttons for information about the dialog box: 
 Reboot
 Restart Windows
 Return to MS-DOS



Confirm Option Delete
Using this dialog box, you can confirm that you want to remove the specified Windows 
component file from your system. You can reinstall the option later by using the Microsoft 
Windows disk set. 
You can choose one of the following buttons. 
Use To
Yes Delete the file shown in this dialog box from your hard disk. 
Yes to All Delete all of the files you selected in the Add/Remove Files dialog box. The 

files are deleted from your hard disk. 
No Not delete the file shown in this dialog box. The dialog box will display each 

remaining file you selected in the Add/Remove Files dialog box, so you can 
choose whether to delete or keep each one. 

Cancel Close the dialog box without deleting any files from your hard disk. 



Adding and Removing Files
Using this dialog box, you can select specific Windows files to be added to or removed 
from your system. This enables you to use your disk space to your best advantage. 
The box on the right contains names of files that are currently installed on your system or
that you have selected to be added to your system. 
The box on the left contains names of files that currently are not installed on your system 
or that you have selected to be removed from your system. 
Choose one of the following buttons for information about the dialog box: 
 Add
 Remove
 Add All



Search for Applications
Using this dialog box, you specify where Setup should search for applications to set up to 
use with Windows. 
For Keyboard Instructions on searching for applications, press ENTER. 
To specify where you want Setup to look
1 Select the place(s) you want Setup to search. You can specify more than one place--for 

example, both your path and drive C. 
2 Choose the Search Now button. 



Keyboard Instructions

To specify where you want Setup to look
1 Press TAB to move the selection cursor to the Setup Will Search area. 
2 Press the UP or DOWN ARROW key to move to each option you want. 
3 Press the SPACEBAR to select an option. 
4 Press TAB to move to the Search Now button. 
5 Press ENTER. 



Windows Tutorial
The Microsoft Windows Tutorial is a two-part, online, interactive application that can help 
you become familiar with using Windows. 
The first lesson is designed to familiarize you with using a mouse. It guides you through 
very basic mouse techniques and gives you a chance to practice before you start working
with Windows. 
The second lesson introduces you to basic Windows techniques and gives you the 
opportunity to practice what you have learned. 



Select PIF
Using this dialog box, you specify which program information file (PIF) Windows should 
use to run a specific application. This application has more than one PIF associated with 
it; each will run the application in a slightly different way. For example, one PIF might 
open a certain data file each time the application starts. Another PIF might start the 
application without opening any file. 
You can select multiple PIFs if you want to be able to run the application in different ways 
at different times. 
Select the PIF that best describes the way you want to run the application. It is 
recommended that you use the PIF supplied by the manufacturer, if one is available. 

Select the PIF(s) you want to use, and then choose the OK button. 



Replace/Retain Existing PIF
Using this dialog box, you direct Setup to either replace or keep an existing program 
information file (PIF) for an application. The application you are setting up has a PIF 
already installed on your system. You can choose either to keep the PIF that exists for the 
application or create a new PIF to use for running the application. 
Choose one of the following buttons for more information about the dialog box: 
 Create
 Replace
 Cancel



Contents for Windows Setup Help
You can use Windows Setup to change system settings, set up applications to use with 
Windows, and add or remove optional Windows components. 
To learn how to use Help, press F1. 
Click one of the following topics. Or press TAB to move to the topic you want, and then 
press ENTER. 

How To...
Add Windows Components 
Change System Settings 
Remove Windows Components 
Set Up Applications 

Commands
Options Menu Commands 



Options Menu Commands
Use the scroll bar to see more commands. 

Change System Settings
Changes settings for your display (monitor), keyboard, mouse, and network. 
If you change system settings, Setup prompts you to restart Windows so that the changes
can take effect. 

Set Up Applications
Sets up the applications already on your hard disk(s) so that they will run with Windows. 

Add/Remove Windows Components
Installs optional Windows components, such as Readme files, Windows Accessories, and 
Windows Games on your system. Also deletes optional components from your system. 

Exit
Quits Windows Setup. 



Adding Windows Components
Using Windows Setup, you can add any Windows components to your system that you 
may have chosen not to include when you first set up Windows. 
You can select all or only certain parts of a component. For example, you may want to set 
up some of the Accessories applications, but not others. 
To add a complete component
1 Select (check) the check box next to the Component description. 
2 Choose the OK button. 
To add specific component files

Choose the Files button for the component. Then complete the dialog box that 
appears. 

For help, choose the Help button or press F1 while using the dialog box. 



Changing System Settings
If you change to a system configuration that is different from the one you had when you 
set up Windows, you can use Setup to change your software and hardware settings. For 
example, you might want to change from an enhanced graphics adapter (EGA) to a video 
graphics adapter (VGA). You must have the appropriate hardware to support these 
changes. You can change your display (monitor), keyboard, mouse, or network settings. 
Note: You will have to restart Windows or your system if you change settings by using 

Setup. For this reason, it is a good idea to close all your running applications before 
you use Setup. 

To change your display, keyboard, mouse, or network
1 Make sure that your hardware is set up to match the setting you are changing. Check 

your hardware documentation. 
2 From the Options menu, choose Change System Settings. 
3 Click the arrow at the right of the setting that you want to change to open the list. Or 

press ALT+DOWN ARROW. 
Each list displays drivers or devices supported for that setting. Make sure your 
hardware is listed. Use the scroll bar or arrow keys to see more of the list. 

4 Select the setting that you want. 
5 Choose the OK button. 

Setup may prompt you to insert a Windows disk into drive A. If it does, put the disk in 
drive A and close the drive door, or type the path of the appropriate device-driver file. 
Then choose the OK button. 

6 From the Options menu, choose Exit. 
7 Make sure there are no disks in any floppy disk drive, and then choose the Reboot 

button (if it appears) to restart your system. (After restarting your system, you can 
start Windows by typing win at the MS-DOS prompt.) 
Or choose the Restart Windows button. 
The next time you start Windows, the new settings will be in effect. 

Sometimes it may be necessary to run Setup from outside Windows. For example, if 
changes to your files prevent Windows from running correctly, you must run Setup from 
MS-DOS. For more detailed information, use a text editor to view the SETUP.TXT file, 
located on Disk 1 of your Windows disks. 
To run Setup from MS-DOS
1 Quit Windows. 

Do not use the MS-DOS Prompt icon in the Main group window, as this will result in an 
incorrect setup. 

2 At the MS-DOS prompt, type setup, and then press ENTER. 
To completely reinstall Windows
1 Quit Windows. 
2 Delete the Windows directory and all the files and subdirectories contained in it. 
3 Place your Microsoft Windows Disk 1 in drive A, and then change to drive A. 
4 At the MS-DOS prompt, type setup, and then press ENTER. 
5 Follow the Setup instructions on the screen. 



Removing Windows Components
Using Windows Setup, you can remove several accessory applications and other 
components that were supplied with Windows but are not essential to running Windows. 
This is useful if your system has limited disk space. 
You can select all or only certain parts of a component. For example, you may want to set 
up some of the Accessories applications, but not others. 
To remove a complete component
1 Clear the check box next to the Component description. 
2 Choose the OK button. 
To remove specific component files

Choose the Files button for the component. Then complete the dialog box that 
appears. 

For help, choose the Help button or press F1 while using the dialog box. 



Windows Setup Options
Using this dialog box, you can select from three optional procedures to perform after all 
basic Windows files have been set up on your system. 
A procedure marked with an X in its check box will be performed unless you remove the X
by clicking the box. 
For Keyboard Instructions on selecting optional procedures, press ENTER. 
Choose one of the following buttons for information about this dialog box: 
 Set Up Only Windows Components You Select
 Set Up Printer(s)
 Set Up Applications

To quit Setup Help
From the File menu, choose Exit. 
Or press ALT+F4. 



Keyboard Instructions

To perform optional procedures marked with an X
Press ENTER. 

To select or cancel an optional procedure
1 Press and hold down ALT and press the underlined letter of the option. 

For example, press ALT+P to move to the Set Up Printers option. If the check box 
contained an X, this action removes the X. If the box was empty, this action places an 
X in the box. 
Procedures marked with an X will be performed. 

2 Press ENTER to continue Setup. 
To quit Setup Help

Press ALT+F4. 



Modify Your System Files
In this dialog box, you specify how changes will be made to your CONFIG.SYS and 
AUTOEXEC.BAT files. These changes need to be made if you want Windows to be set up 
optimally on your computer. 
For Keyboard Instructions on modifying system files, press ENTER. 
Choose one of the following buttons for information about the dialog box: 
 Setup will make changes for you
 You can review and edit proposed changes
 You can make changes later

Choose the following buttons to see the changes Setup makes to your system files: 
 Changes to AUTOEXEC.BAT
 Changes to CONFIG.SYS

To quit Setup Help
From the File menu, choose Exit. 
Or press ALT+F4. 



Keyboard Instructions

To have Setup modify your system files for you
Press ENTER. 

To select another option
1 Use the DOWN ARROW key to select the option you want. 
2 Press ENTER to continue. 
To quit Setup Help

Press ALT+F4. 



Reviewing Changes to System Files
In this dialog box, you can review the changes Setup proposes for your system files. The 
top box shows the proposed (modified) version of your AUTOEXEC.BAT or CONFIG.SYS file.
The lower box shows the current (unchanged) version. 
To make additions or revisions to the proposed file, edit the file in the top box. Use the 
scroll bar to see more of both files so you can compare lines. When you have finished 
editing, choose the Continue button to save the changes and continue with Setup. 
For Keyboard Instructions on reviewing changes to system files, press ENTER. 



Keyboard Instructions

To save proposed changes to system files and continue Setup
1 Press ENTER to accept the changes. 
2 Press ENTER when prompted to back up your old system files as AUTOEXEC.OLD and 

CONFIG.OLD. 
To edit a system file
1 Press TAB until the insertion point appears in the Proposed Changes box. 
2 Use the arrow keys to move the insertion point to the place where you want to make a 

change. 
3 Type new text or edit the existing text. 

Use BACKSPACE or DEL to delete unwanted characters. 
4 Press ENTER when you have finished making changes. 
5 Press ENTER again when prompted to back up your old system files as AUTOEXEC.OLD 

and CONFIG.OLD. 
To move the insertion point within a system file
Press To move
LEFT or RIGHT ARROW Left or right one character. 
UP or DOWN ARROW Up or down one line. 
PAGE UP or PAGE DOWN Up or down one screen. 
CTRL + PAGE UP or PAGE DOWN Left or right one screen. 
CTRL+HOME To the top of the file. 
CTRL+END To the end of the file. 
To quit Setup Help

Press ALT+F4. 



Saving Proposed Versions of Your System Files
In this dialog box, you can direct Setup to make a record of the proposed changes it 
would make to your system files. After setting up Windows, you should check these files 
and then make the proposed changes yourself. To save proposed changes, choose the 
Continue button. By default, Setup saves the files as AUTOEXEC.WIN and CONFIG.WIN in 
your Windows directory, but you can change the names to any valid MS-DOS filenames. 
For Keyboard Instructions on saving changes to system files, press ENTER. 



Keyboard Instructions

To save changes under the proposed filenames
Press ENTER. 

To edit the name of a backup file
1 Press TAB to move the insertion point to the filename you want to edit. 
2 Use the arrow keys to move the insertion point within the edit box. 
3 Type a new name or edit the existing name. 

Use BACKSPACE or DEL to delete unwanted characters. 
4 Press ENTER when you have finished making changes. 
5 Press ENTER again when you are prompted to save the backup files. 
To quit Setup Help

Press ALT+F4. 



Setting Up Existing Applications
After you install an application on your system, you can use Setup to make sure it will run
smoothly with Windows. 
You can direct Setup to search: 

Local drives 
The current path 

Setup creates an icon in a Program Manager group window for each application you add. 
However, Setup will add an icon for a non-Windows application only if the appropriate 
program information file (PIF) exists. Setup includes information for many applications, 
but not all. If Setup does not create a PIF for the application you want to add, you can 
create one by using PIF Editor. 
If you are adding just one Windows application, it might be easier to use Program 
Manager. If you are adding several Windows applications or one or more non-Windows 
applications, using Setup is the best method. 
To add an application to Windows
1 From the Options menu, choose Set Up Applications. 
2 Choose the OK button to search all your local drive(s) for existing applications. 
3 In the list, select the locations you want Setup to search. 
4 Choose the Search Now button. 

When Setup finishes its search, it displays in the left box the names of the applications 
it found. These names are from the application, they are not supplied by Setup. You 
must move each application that you want to set up from the left box to the right box. 

5 Click each application you want to select. 
Or use the arrow keys to move to each application you want, and then press the 
SPACEBAR to select it. 
When you select an application, Setup displays each application's path in the lower-left
corner of the dialog box. Because more than one application can have the same name,
check the path to make sure the application is the one you want. 
Also, since Setup identifies each application by its program filename, at times it may 
display the wrong name. (For example, WordPerfect and Microsoft Multiplan both use 
the name WP.EXE.) Check the names of the applications Setup finds to verify that they 
are the correct applications. 

6 Repeat step 3 to select additional applications. 
To cancel a selection, select it again. 

7 To move selected applications to the right box, choose the Add button. Or press ALT+A. 
Or, to move all the listed applications to the right box, choose the Add All button. Or 
press ALT+D. 
If you change your mind after adding an application to the right box, select the 
application, and then choose the Remove button. Or press ALT+R. 

8 Choose the OK button after you have added all the applications you want to set up. 



Applications Found on Hard Disk
This list displays all of the applications Setup has found on your drive(s). 

To set up an application, select the one you want, and then choose the Add button. 
Setup displays each application's path in the lower-left corner of the dialog box as it is 
selected. 

To set up all the listed applications, choose the Add All button. 



Set Up for Use With Windows
This list displays the application(s) you want to set up to use with Windows. If you 
change your mind about setting up an application, you can delete it from the list. 

To remove one or more applications, select the application(s), and then choose the 
Remove button. 



Add Button
Choosing this button moves the selected applications from the left box to the right box, 
which contains the list of applications you want set up. 



Remove Button
Choosing this button moves the selected applications from the right box to the left box, 
which contains applications that won't be set up. 



Add All Button
Choosing this button moves all the applications from the left box to the right box, which 
contains the list of applications that you want set up. 



File Name
Select a filename, and then choose the OK button. 
If the program file you want is not in the File Name list, you may have to change 

directories by selecting a directory in the Directories list. 
Or you can type a filename in this box and then choose the OK button. If the file is 

not in the current directory, include the path. 



List Files of Type
Open the list, and then select the type of file you want to appear in the File Name 

box. 



Directories
Select the directory that contains the program file you want to use. The names of the 

files in that directory will appear in the File Name list. 
If the directory you want is not in the list, you may have to change drives by selecting

a drive in the Drives list. 



Drives
Open the list, and then select the drive that contains the program file you want. The 

directories on that drive will appear in the Directories box. 



Reboot
Choosing this button restarts your system. After restarting your system, you can start 
Windows by typing win at the MS-DOS prompt. All options and settings you chose during 
Setup will be in effect. 
Before restarting your system, be sure to remove any floppy disks from your drive(s). 



Restart Windows
Choosing this button restarts Windows. Some options and settings you chose during 
Setup may not take effect until the next time you restart your computer. (You can restart 
now by choosing the Reboot button. After restarting your system, you return to the MS-
DOS prompt.) 
Before restarting Windows, be sure to remove any floppy disks from your drive(s). 



Return to MS-DOS
Choosing this button returns you to the MS-DOS prompt. Some options and settings you 
chose during Windows Setup may not take effect until the next time you restart your 
computer. (You can restart now by choosing the Reboot button. After restarting your 
system, you return to the MS-DOS prompt.) 



Add
Choosing this button moves the selected file(s) in the left box to the right box, indicating 
they will be installed on your system when you choose the OK button. 

To add one or more files to your system, select the file(s) in the left box, and then 
choose the Add button. The filenames are moved to the right box. 



Remove
Choosing this button moves the selected file(s) in the right box to the left box, indicating 
they will be removed from your system when you choose the OK button. 

To remove one or more files from your system, select the filename(s) in the right box,
and then choose the Remove button. The filenames are moved to the left box. 



Add All
Choosing this button moves all files from the left box to the right box, so that all files 
previously not set up on your system will be added when you choose the OK button. 

To add all of a component's files to your system, choose the Add All button. 



Create
Choosing this button keeps the existing PIF on your system, in addition to the program-
item icon associated with the PIF, and creates a new, additional PIF (and icon) that you 
can use to run the application. You might want to choose this option if the existing PIF is 
set up with special parameters you don't use all the time; for example, it may load a 
particular file when the application is started. 
The new PIF is created using information supplied by Windows version 3.1 about how to 
run the application. This information has been tested, so the application will most likely 
work on your system. You do not have this assurance with the existing PIF, since it was 
probably created for an earlier version of Windows. 



Replace
Choosing this button deletes the existing PIF and creates a new PIF to replace it. All 
program-item icons associated with the application through the old PIF will now use the 
new PIF to run the application. The new PIF will most likely enable the application to run 
on your system. 



Cancel
Choosing this button keeps the existing PIF on your system, and no new PIF is created. 



Set Up Only Windows Components You Select
Select this option if you want to add only some of the additional Windows components to 
your system. This can be useful if you have limited space available on your hard disk. 
You can set up an entire component, such as Windows Games, or you can select only 
certain game files to be set up. In addition, many components, such as the Games and 
Accessories, have online Help available. You can choose not to set up the Help files; 
however, if you set up a file, it is recommended that you also set up the accompanying 
Help file. The Help file contains easily accessible information about the application. 



Set Up Applications Already on Hard Disk
Select this option if you want to use Windows to set up applications already on your 
system. For example, you might have a copy of WordPerfect that you would like to set up
to run with Windows. 



Set Up Printer(s)
Select this option to set up a printer to be used with Windows. During printer setup, you 
need to know the type of printer you have and the name of the port to which it is 
connected. 
Computers are generally equipped with one or more parallel ports (for example, LPT1) 
and one or more serial ports (for example, COM1). You can use these ports to connect to 
hardware devices such as a printer. For information about the ports on your system, see 
your hardware manual. 



Setup can make all modifications for you
If you want Setup to make all the necessary changes, leave the first option selected and 
choose the Continue button. Setup saves your old system files as AUTOEXEC.OLD and 
CONFIG.OLD. Subsequent backup copies will have a three-digit extension (for 
example, .001). Or you can edit the filenames to save your old files under different 
names. 



You can review and edit changes before modifications are made
If you select this option, Setup copies your AUTOEXEC.BAT and CONFIG.SYS files and 
makes changes to the copies. Then Setup displays both the proposed new file and your 
original system file so that you can review the changes and make any further revisions 
yourself. 
When you are satisfied with the changes, Setup creates backup copies of your original 
system files and saves the proposed new files as your CONFIG.SYS and AUTOEXEC.BAT 
files. Backup files are saved as CONFIG.OLD and AUTOEXEC.OLD in the directory where 
the original files were located. Subsequent backup copies will have a three-digit 
extension (for example, .001). 



You can make the modifications later
Select this option only if you are familiar with MS-DOS configuration files and can use a 
text editor to make the changes after setting up Windows. 
If you select this option, you must make all the changes to your AUTOEXEC.BAT and 
CONFIG.SYS files yourself after Windows is set up. Setup asks if you want to save copies 
of your system files with proposed changes, as a record. You can then use these copies 
to make sure that you include all the necessary changes. 
Backup files are saved as CONFIG.OLD and AUTOEXEC.OLD in the directory where the 
original files are located. If files already exist with those names, Setup assigns numeric 
extensions, using .000 as first choice; if that file exists, the second choice is .001, and so 
on. 



Setup makes the following changes to AUTOEXEC.BAT:
Adds to your path the directory in which you are setting up Windows. 
Adds the SMARTDRIVE.EXE command line, if appropriate for your system 

configuration. 
Creates a TEMP directory in the Windows directory and sets the TEMP variable to it (if

you do not already have a TEMP variable set). 



Setup makes the following changes to CONFIG.SYS:
Adds the HIMEM.SYS line. 
Adds the SMARTDRIVE.EXE /double_buffer line, if needed by your system. 
Updates RAMDRIVE.SYS, if it is in use. 
Updates EMM386.EXE, if appropriate. 
Updates your Microsoft or Hewlett-Packard mouse driver. 
Deletes any incompatible drivers. 
Adds or updates your EGA.SYS driver, if you are using an enhanced graphics adapter 

(EGA) or a Mouse Systems mouse. 




